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Question
How do | create a FDL connection to a SIMATIC S5 over PROFIBUS for
the SIMATIC NET OPC Server with the SIMATIC NET PC Software?

Answer

The instructions and notes listed in this document provide a detailed
answer to this question.
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Assignment of tasks

In this example a CP5611 is used, that implements FDL communication
over the OPC Server with a S5 station on PROFIBUS.

The method described in these instructions also applies to the
communications processors CP5613/14 (A2), CP5621, CP5511 and
CP5512.

Condition

It is assumed that one of the two following configuration tools is installed:

e NCMPC
NCM PC is supplied with the SIMATIC NET CD and allows you to
create PC projects and open STEP 7 projects. It is, however, not
possible to edit S7 blocks in the STEP 7 project with this software.

e STEP7
STEP 7 is a separate software package with which you can create S7-

400, S7-300 and PC projects. S7 blocks can be edited with this
software.

Only one of these tools can be installed.

In chapter 2 “Configuration of the PC station” is described the configuration
of PC station so that you can use the FDL communication over PROFIBUS
to exchange data between PC station and S5 station.
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Configuration of the PC station

After successful completion of the hardware and software installation of the
SIMATIC NET CD and the configuration tool and after restarting your
computer, you start NCM PC or STEP 7 with "Start - (in Windows XP: All
Programs->) SIMATIC - SIMATIC Manager or SIMATIC NCM PC
Manager or using the desktop icon of the same name.

Create a new project with "File > New".

Figure 2-1 giving the project a name

Newproject x|
Uszer projects I

Marme | Storage path
@ Example F:\Program Filez\SIEMENS\SIMATIC.MCMA\S Tpeof\E warmple

< | »
Name: Type:
IF"E_Statinrl I_'_-'rnp-r t j
I” E Libraw
Storage location
I:\Frngram Fles\SIEMENSASIMATIC. HCMAS pray Browse... |

carcel | __Heb_|

Confirm the project name you have entered (in the example: "PC_Station")
with OK. An empty STEP 7 or NCM PC project is then created.
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Flgure 2-2 inserting the PC station

=
Ele Edt [Insert PLC Yiew Options Window Help

Press F1 ko gat Help. | |CPS611(MPI) | 7

With the menu command "Insert - Station > SIMATIC PC Station", you
insert the PC station.

Figure 2-3 changing the name of the PC station

k= SIMATIC NCM PC Manager - PC_Station (i 1ol x|
file Edt Insert PLC View Options Window Help

D27 & |mle] sl 27 =lm 5 =1%| %8| Bl=m| x|
=10 x|
Press F1 to get Help. [CPS611{MPT) 4
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Give the PC station you have just inserted the same name as your
computer (in the example: "PC_Station").

Now open the hardware configuration of the PC station by selecting the PC
station, then pressing the right mouse button and selecting "Open Project"

(STEP 7: "Open Object").

Figure 2-4 hardware configuration of the PC station

[ SIMATIC NCM PC Config - [PC_Station (Configuration) -- PC_Station]

=1oix|

B Station Edi Insert PLC Wiew Options Window Help =18l x|
DleE-{2 (% & “lel alu(®h 2 v

EC— Al ol
e — \End | | nﬁ

2

2 _

4 3]

5 PROFIBUS P&

& * ﬁ PROFINET 10

i | @B SIMATIC PC Station

Press F1 to get Help.

S o

Index Madule Order number Fim.. | M..| C.

1 <

4 —

5

3

7

8 PROFIBUS-DP slaves for SIMATIC $7, M7, and C7 EI
g |distributed rack) =l
10 -|

&

You will see an empty rack. If you cannot see the hardware catalog, click

on the button marked in red.
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Figure 2-5 selecting the modules from the hardware catalog

E;':_SIMA'IIC NCM PC Config - [PC_Station {Configuration) -- PC_Station]

_(ol x|
@l Station Edt Insert PLC View Options Window Help =81
D@ % & =2 sl @] 28 el
E G — 3 L
I | Bt | a
2
3
2 = ¥ FROFIBUS OP =
5 PROFIBUS-PA
3 33 PROFINET 10
7 =8 SIMATIC PC Station
8 - CP Industiial Ethemet
JED I - Il = ceeroreus
’ _’l_, CP 5411
I CP 54122
CP541242H
5| o P = (] CP 5511
{5512
Index Module Order rumber Firm... G =L CP o6
1 = ... SW V6.0 5P4
2 Sw VB0 SPS
@] CP 5613 —
o @ (] CP5613A2
£ @] CP5613F0
13 & 1
7 @ CPseld =l
] BGK1 56114400 £
3 SIMATIC NET CP 5611 PROFIBUIS, 57 connections, DP ——
10 - master, DPV1, DP slave, PG functions, DP master class
~1  ||2. PCl bus, routing, SIMATIC NET CD 7/2001 SP5 ...
Press F1 to get Help. ' - cha 4

Now place your PC modules in this rack (for example by dragging them
from the hardware catalog).

If you use a CP5613/14 (A2) (or CP5511 or CP5512) you will select the

CP5613/14 (A2) (or CP5511 or CP5512) from the STEP7 hardware

catalog.

If you use a CP5611 A2 or CP5621 you will configure these modules

asCP5611.

The following dialog appears automatically after you insert the module in

the PC station.
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Figure 2-6 address assignment dialog

Properties - PROFIBUS interface CP 5611 (R0/S9) ]

General Parameters ]

Ix

Addiess: IE > | If a subnet is selected,
the nest avalable address is suggested.

Subnet:

- nok networked -

Cocel_| _beb_|

Click on the button "New" to create a new PROFIBUS subnet. The property
view of the PROFIBUS subnet will open. Change to the register ,Network
Settings“and set the relevant bus parameters.

Figure 2-7 configuring bus parameters for PROFIBUS subnet

Properties - New subnet PROFIBUS |

General  Network Settings |

: Dptiors...
Highest PROFIBUIS
Address: 126 - " Change
Tranzmission Rate: 19.2 Kbps :I

9375 Khps

187.5 Kbps

500 Kb
Profile: DFP

Standard

Universal [DP/FMS])

User-Defined

Bus Parametess... |

Cancel | Help |
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Confirm the dialog with ,OK".

Figure 2-8 property view of the CP5611

Properties - PROFIBUS interface CP 5611 (R0/S9) x|

Genetal Parameters I

Address: {E3)
Highest address: 126
Transmizsion rate: 1.5 Mbps

Subnet:

== ok Aetveoiload - Mew... |

ot ||

Connect the CP5611 to the PROFIBUS subnet which you have just
configured or to a PROFIBUS subnet which already exist.

Close the property view of the CP5611 with ,OK*".
The configuration and networking of the CP5611 is finished now.
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Figure 2-9 hardware configuration — projecting the CP5611

BEHW

Station

Konfig - PC_Station =l0lx
Bearbeiten  Einfiigen Zielsystem Ansicht Extras Fenster Hife

D[22 (%] & (e skl B %8 M|

Mec

_Station (Konfiguration) -- FAQprojekt_IE_SR

(e

.Suciwnc ] it nﬂ

Profil: iSlandard |
¥ PROFIBUSDP a
222 PROFIBUS P4

4% PROFINET 10

- SIMATIC 300

w-[ SIMATIC 400

Bl SIMATIC PC Based Control 300/4

|‘
R 1

=18, SIMATIC PC Station
[ Benutzer Applikation
[ Controller

-] CPndustrial Ethemet

Al | = =] CP-PROFIBUS
CP 5411
CP 541242 —
_Q_!j!l[ﬂ] e CP541242H
S =] CPEsN
Index | [1 Baugruppe Enmse= ) bkl des 4 cPs512
= () CP 5611
L SWVBOSPE
Gl VIR N SPR
: «J : _I_
5 BGK1 56114400
§ gl?mnc NET CP 5511 PFIDFIBUS i
= el el
5 DP-Slave, Pﬁfmktmmn Routing, =l

Driicken Sie F1, um Hilfe zu erhalten.

)|

The
slot.

module has now been placed in a slot in the rack. You can select any
There are no restrictions.

Figure 2-10 configuring the OPC server

[iZHw Konfig - PC_Station j -1o|

Station

Bearbeiten Einfigen Zielsystem Ansicht Extras Fenster Hife

D[(2+® (% & D2 sl @] % a2l

C_Station (Konfiguration) - FAQprojekt_IE_SR Suchen: | EL'

Brofit | Standard

F OPC Server + PROFIBUS-DP
PROFIBUS-PA

=22 PROFINET 10

22 SIMATIC 300

@ [ SIMATIC 400

@ [l SIMATIC PC Based Control 30074

=8, SIMATIC PC Station

CP 5611 =1+ Benutzer Appliation

Applikation

=+ OPC Server

<

| ~ [ .. swve0osPe

] SwWWVEOSPS ..

] Swvel ..
R (N d swve2spi..
Index Baugruppe Bestell Fimware | MPl-Adres:

[ Controller

{1 CP-Industrial Ethemet

=] CPPROFIBUS
OPC Server V621 a

CP 5411

P RAT2 &2
4

iz

e ] -2l Boud B D S

-

OPC Server -
OPC Server fir die Protokolle DP, -
FDL, FMS, 57[subnetzibergreifend).

ISO/TCP, SNMP, DP Master Klasse _l

Dricken Sie F1, um Hilfe zu erhalten.

e ]

V1.0

31.03.2008 11/36



Copyright © Siemens AG 2008 All rights reserved

Guide_FDLS5_OPC_e.doc

SIEMENS

FDL connection over PROFIBUS

Entry-ID: 16733087

Select the OPC server in the hardware catalog and then drag it to any slot.

Figure 2-11 button ,NetPro*

D[(2-[2 (% & Bl dles| [ =((32) a2l

Now open the NetPro program. Use the button marked red in the toolbar in
Figure 2-11 button ,NetPro“.

In NetPro you configure a FDL connection to exchange data between the
OPC server and the S5 station.

Figure 2-12 configuring the FDL connection in NetPro

£i%NetPro - [PC_Station (Netz) - C:\Programme...\S7proj\PC_Stati] =] F3

99 etz Bearbeiten | Einfigen Zielsystem Ansicht Extras Fenster Hife -8 %

@ln |qH| Ql | Netzobjekte Chrl+G @Rl 1 | EH

e I S N | 7
MPI Suchen: nj; nﬂ

Auswahl der Netzobjekte

= ¥ FROFIBUSDP
¥ PROFIBUS-PA
&% PROFINET 10
[#-{_] Stationen
#-_] Subnetze

v
< | 3
Lokale ID Partner D |Partrer [Tym g
E
i i [ ~ | ||PROFIBUS-DP-Slaves —=
4| | » der SIMATIC 57, M7
Fidgt eine neue Yerbindung in der Verbindungstabelle ein. 216 Y1 [Enfg| 2| e . |

Select the OPC server and choose the menu command "Insert > New
Connection" to create a new connection for the OPC server or right-click
the OPC server =2 ,Insert > New connection“.

V1.0
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Figure 2-13 Insert a new connection in NetPro

x
r~ Connection Partres

=-[a] In the cument project
= &P PC_Station
-------- [Unspecified)
e Bl broadoast stations
- Bl mlticast stations
& In unknown project

Eroject | E

g Statiore I[Unspeciﬁed]
:)5‘ Medule I

o

o\

g — Connection

g Type:

3

¥ Display properties Before inserting

| oK I Apply Cancel Help

Because the communication partner isn’'t configured in the same S7 project
like the PC station, you have to configure unspecified connection. In the
dialog box “Connection Partner‘you have to select ,Unspecified“for the
connection partner.

Furthermore you have to select the connection type ,FDL connection”.

Click on the button ,Apply” so that the property view of the FDL connection
will open.
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Figure 2-14 property view of the FDL connection - register ,General Information“

%
General Information I Addiesses |Dptinm| EIF'C' Overview |
— Local Endpoirt

Name [ID]): F[ZIL Connection]
ViaCP:  |CP5611

Houte. .. |

coud_| _ter

Insert a name for the FDL connection. Following change to the register
"Addresses".

Figure 2-15 property view of the FDL connection - register ,Addresses*

x
General Information  Addresses | Options| OPC | Overview |

Descibes the addiess parameters of the local endpoint of an

FOL-connection.

Local Remate
PROFIBUS 2 -3
address:;
LSAP: 2 =l E =]
I Eree |aver £ access

coct | _teo_|

By indicating the PROFIBUS addresses and LSAPs you uniquely identify
the FDL connection between the PC station and the S5 station.

For remote set the PROFIBUS address of the S5 station. Set the LSAPs to
uniquely identify FDL connection. For local you have to set the LSAP of the
PC station and for remote you set the LSAP of the S5 station.

V1.0
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NOTE You will have to consider the indication of the PROFIBUS addresses and
LSAPs if you configure the FDL connection in the S5 station.
Confirm the property view of the FDL connection with ,OK*. So you come
back to the dialog ,Insert New Connection®. Confirm this dialog with ,,OK".
The FDL connection which you have just configured is shown in the
connection table of the PC station.
Figure 2-16 connection table
isNetPro - [PC_Station (Network) -- C:\Program Files\,...\S7proj\\PC_Stati] =10x
98 petwork Edt Insert PLC Wiew Options MWindow Help &l x
(@ (% & (e dnlia| 8] (L[]
PR (1 :I gix
Find | il
T Selection of the network
PC_Station B L
5611 -3 PROFINET 10
-] Stations
2] (] Subnets
2
| | Llﬂ
_5|
- , |
Readv [PCinternal (locall % 268 ¥ 159 IChe ~
Now the configuration of the of the FDL connection is finished.
You have to save the configuration in NetPro.
You have to leave open the program NetPro while initialization of the
CP5431 and configuration of the FDL connection in the S5 station.
V1.0 31.03.2008 15/36
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3 Configuration of the SIMATIC S5

3.1 Initialization of the CP5431 and configuration of the FDL
connection
Starten Sie STEP 5 Uber Start > SIMATIC > STEP 5
Wechseln Sie lUber die Taste "F9" in das Konfigurationstool des CP5431
"SINEC NCM COM 5431".

NOTE The configuration tool ,SINEC NCM COM 5431" is an additional software,
which is integrated STEPS5, to configure the CP5431. This software isn’t
included in the standard STEP 5 package. You have to order it
separately.

Initialize the CP5431 using the ,Edit > CP_Init*‘menu.
Figure 3-1 Initialization of the CP5431
=10] x|
SIHEC HCMpY
Edit - CP Init Basic Imitialization Source: C:oQFAQFOL
Imit. data: SIMATIC details 5
L2 address = {EE! Base SSHR = @
Active / passive = Ho. of interfaces :
Hetwork file = HEM. K
Informative parameters:
Submodule type b Submodule size
Medule ID : CP5431
Firmare version =
Date created =
Plant designation : h
4 L3 v
Enter the PROFIBUS address of the CP5431 (L2 address). This address
has to correspond to the PROFIBUS address which you have configured
for remote in NetPro (see Figure 2-15 property view of the FDL connection
- register ,Addresses").
The Base SSNR specifies the CP5431 in the rack. This interface number
must be used later in the block calls in the S5 program.
Apply the settings with ,F7“.
V1.0 31.03.2008 16/36
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Open the ,Edit & Links > S5-S5 Links" dialog.
Figure 3-2 creating the S5-S5 Link

[=STEP 5

CP type: CP5431
Link Editor 55-55 Links Source : C:QFAQFDL

Local L2? station address 3
Remote L2 station address .

PRID CH/L/I) =
ssap 3
DsaP ]

Parameters sending: Parameters receiving :

SSHR : SSHR : ([l
AHR :@ AMR = H_ljj

i o s e — 1 o 11— —

The following declarations have to correspond to the configuration in
NetPro:

e Enter the PROFIBUS address of the CP5611 under “Remote L2 station

address”.

e Because the OPC server has a high priority by default, you have to

select "High" for PRIO.
e To identify the link enter SSAP = 3 (in NetPro: remote LSAP of the

communication partner) and DSAP =2 (in NetPro: local LSAP of the PC

station).

¢ You have to set the ,Parameters sending“and ,Parameters receiving“to
exchange data between PC station and S5 station. You have to enter
the offset interface number of the PLC for SSNR (with a PLC offset
always is 0). The job numbers which are entered under ANR you have
to account when you call the SEND und RECEIVE in the S5 program.

Apply the settings with ,F7*.

With ,Edit - Global Network Parameters“you open the global bus
parameters and bus times of the CP5431.

V1.0
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Figure 3-3 global network parameters

-0l

C HC

SINHE
Edit Global Hetwork Parameters Source: HETZ1HCHM.BPE

Highest active L2 station address in the network file : 3
Curmulative topology info:

Ho. of remote active stations = L Highest station address (HSA) : R[]

Bus parameters:
Data rate
Default SAP
Maximum no. of retries
Medium redundancy

Bus parameter data :
Slot time (TSL)
Setup time (TSET)
Minimum station delay (min TSDR)
Haximum station delay (max TSDR)
Target rotationm time CTTR)
GAP update factor (G)

2.0010
-05336
-10005%
-65366
33.350

Select the required transmission rate for data rate and recalculate the bus
times again by using F1 “CALCULATE?". In this example the data rate is
1500000 bit/s, which mean 1, 5 Mbit/s.

Now change again to the S7 project in NetPro to synchronize the bus times
of the CP5431.

31.03.2008 18/36
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3.2 Synchronization of the bus times
Figure 3-4 opening the object properties of the PROFIBUS subnet
i"@l_};_iﬂetPro - [PC_station {(Network) -- C:\Program Files\,...\S7proj\PC_Stati] 5 ;]E[ﬂ
% Network Edt Insert PLC View Options Window Help =B8] x
(9 (%) @| w|e| bl 8| o2 [@z ] N
PROFIBUS(1) 2 ol
FROFIBUS Find: | n_flnﬂ
T Copy Chrl+C :
. oolete ol Selection of the netwark.
i 3} ﬂl PROFIBUS DP
g E:(E_?:atlon Prink parameters. .. ? 22 PROFIBUS-P4,
Server |5811 — [+ 552 PROFINET 10
- E -] Stations
L . Alt+Return -] Subnets
] | s
Station _|Interface [Address [Device number |
PC_Station CP 5611 2 -
FPROFIEUS-DP slaves for SIMATIC E
57, M7, and C7 [distributed rack]
Displays properties of the selected object fFor editing, [PCinternal (local) % 221 ¥ 41 [Chg /||
In NetPro right-click on the PROFIBUS subnet, which is assigned to the
CP5611, and open the object properties of the PROFIBUS subnet?
Figure 3-5 property view of the PROFIBUS subnet
x
General  Network Settings |
ighest PROFIBUS __ Optors.._ |
Edchmt 126 ¥ " Change
Transmission Rate: 45.45 (31.25] Kbps ]
93,75 Kbps
187.5 Kbps J
500 Kbps
|f~.mw hd
Erofile: OF
Standard
Buz Parameters... |
Cocel | Heb |
V1.0 31.03.2008 19/36
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In the property view of the PROFIBUS subnet - register ,Network
Settings” you select the transmission rate 1,5 MBit/s and the bus profile
»User Defined".

You have to click on the button ,Bus Parameters...“. The following dialog

will open.
Figure 3-6 bus parameters
>
Bus Parameters |
= [T an conlie detitadion ofihe bus nacametere
Tslot_Init [ 3000 bk Tshot 3000 ¢ bt
Ma. T sd: | SBﬂE I bit Tid2: 980  bat
Min.Tsdr: | 15[!3_ I_bit Ty 150t bit
Tset [ s0=] vbi Tid1: 195 t_bit
Tqui [ 0] T 50000 t_bit
= 333 me
Gap Factor: I 503: Tt typically: 8274 t_bat
= 5.5 me
Fetry limat: I 15:
. Watchdog
[ 66934t b
- 44.7 me
Fecaiculate I|
Cocdl_|__ e

You have to adapt the bus times which are displayed according the settings
in the CP5431 of the S5-station (see Figure 3-3 global network
parameters).

Following confirm the dialog with ,,OK".

You have to save and compile S7 project. Therefore select the PC station
in NetPro and click the button ,Save and Compile” in the toolbar. This
updates the information in the S7 project.

Figure 3-7 Save and Compile
x
- Compile -

& ‘Compile and check evenything

" Compile changes only

oK Cancel | Help
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Warning indications can be displayed while proceeding with the “Save
and Compile” of a S7 project. Warnings serve as piece of information and
have no functional effect. In case error warnings occur, search for
possible divergences in the previous steps of the instructions.

V1.0
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Download the configuration into PC station

Open the ,Station Configuration Editor” in the Windows START Menu >
LStation Configuration Editor” or with the following button in the Windows
task bar

Figure 4-1 button “Station Configuration Editor”

Figure 4-2 Station Configuration Editor

Companents | Diagnostics | Configuration Info |

I

Station:  PC_Station Mode; RUN_P '

[New diagnestic entry arived!
Add.. I Edt | felete | Ring ON |

Station Name.. | { Import Station .. | Disable Station

Hep |

Click the button "Import Station...”. A message about restarting the PC
station will open.

V1.0
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Station Configuration Editor

= The station will be restarted,
J,r" i\ - Make sure that no communication iz active over the
" el

componernts involved,
Do pou want to import the station?

Entry-ID: 16733087

X]

| Yes || L No

Confirm the message about restarting the PC station with ,Yes". The
following dialog to select the XDB file, which should be import, opens.

Figure 4-4 selecting the XDB file

mporconiie 20
Look jn: | 3 XDBs x| « @ cF -
=1 (& Desktop
=t u My Documents

,_-1 My Cornputer

S 3% Floppy (&)
e SYSTEM [C)

) Program Files
) SIEMENS

) SIMATICNCH
) 57pmoy
|- PC_Stati

Fiagunel & 5 Open I
. e DATA (D)

Flesoft) o win2X () ol e |

In this dialog you enter the path of the XDB file. The XDB file is always
created in the project by NCM PC / STEP 7 (see Figure 2-1 giving the
project a name). With the combo box ,,Search in: “you navigate in the path

of the XDB file.
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Figure 4-5 Information from the XDB file

Configuration for x0B Import |
Index | Name | Type | Status | Ener |~
1
2 [] oPCSewver  OPCServer
3
4
a5
3
T 1
a —
g ¥ cpsen CP 5611
10
1
12
13
14
15
e ll

@ The XDB import is possible. Refer to the list above for the configuration,

[ Waork in offfine mode [a downdoad to this station is then not possible)

Concel | Hep |

As information, you can see once again which modules and applications
are configured in the XDB file.
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Figure 4-6 PC station is configured

Entry-ID: 16733087

Station Configuration Editor - [ONLINE] x|
Components | Diagnastics | Configuration Info |
Statior:  |PC_Station Mode: RUN_P
Index | Nare | Type Ring | Ststus | Run/Stop | Corn N
1
2 [] OPCSewer OFC Server 53 v
3
4
5
B
7
3 |
g fF creen CF 5611 fa B
10
1
12
13
14
15
16
17 d
Mew diagnostic entry anved!
Add. | Edt | peete. | Araon |
Station Name... | Impon Station... | Disable Station _ |
teb |

Now the import of the XDB file is finished and the configuration is

downloaded.

In the column connection, which is
is also been downloaded.

marked red, you see that the connection

So the configuration of the PC station is finished.
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Download the configuration into CP5431

Change to the configuration tool of the CP5431.
Apply the configuration of the bus time with ,F7“.

Synchronize the network with ,Network - Synchronize Network". The
globally set bus parameters are adopted in the local bus parameters.

Then download the configuration to the CP5431 with ,Transfer > FD >
CP*,

Return to the STEP 5 configuration dialog with ,File > Exit* and ,ESC".
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6 Description of the S5 program

Synchronization of the CP5431 with the PLC using the SYNCHRON call in the
start-up OBs

Insert the following start-up OBs in your S5 program:
e 0OB20
e OB21
e 0OB22

In these OBs you have to program the FB125 "SYNCHRON" call, which
synchronizes the PLC and the CP5431.

Figure 6-1 FB125 ,SYNCHRON" call

Copyright © Siemens AG 2008 All rights reserved
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Calling the SEND/RECEIVE block in OB1
Create the OB1. Form the RLO = 1 with the two statements:
e OMO0.0
e ON MO0.0
Insert the SEND block call (FB120).
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Figure 6-2 FB120 ,SEND* call

Interface number

Job number
displayword

Source type
datablock number
Begin of sendbuffer
Length of sendbuffer

QTYP
DBHR
JANE
LA
PAFE

NOTICE  Specify the length of the send area in words.

Form an RLO = 1 with the two statements:
e OMO0.0
e ON MO0.0

Then add the RECEIVE block call (FB121) after this.

Copyright © Siemens AG 2008 All rights reserved
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Figure 6-3 FB121 ,RECEIVE” call

Ill. | [
JU FB 121

Hame :RECEIVE

S5HH EY Interface number

A-HR EY Job number

AMZW i displayword

ITYp kS Destimation type

EY datablock number

EF begin of receivebuffer

13 Length of receivebuffer
FY

DEHR
IAHF
ZLAE
PAFE

fddresses I8

NOTE The ,SEND"and ,RECEIVE"“blocks are executed only when RLO=1 prior
to the call.

If the length of the receive area is preset with ,-1“the length of the data
will detect automatically (parameter: ZLAE = -1).
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Save OB1 with ,F7”.

Creating the send and receive buffer

Because the send and receive buffer must be located in DB10, this must be
created in the project and declared with an adequate length.

Then download the entire program to the S5 station.
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Start of the OPC Scout

Start the OPC Scout with "Start - SIMATIC - SIMATIC NET - OPC
Scout".

Double-click the ,OPC.SimaticNet“for connection with the SIMATIC NET
OPC server. In the dialog that appears, enter a suitable group name and
confirm this with OK.

Figure 7-1 connecting with the OPC server and enter a group name

[=30PC Scout - New Project1

File View Server 7
=l B 4| E4
|Servers and groups [ltems incl. status information
(=g Serverls) Item Names | Value | Format
=&, Local Serverls) 1
=) 48 OPC SimaticNET
\:; [Mesa araunl
5 oS CET x
& OFC o
& Fof Group Properties:
= 4 Remole Enter a ‘Group Name”
% add | [FOL
Create new group active v
Requested update rate in ms IEDD ﬂ
Successhully connec
I Estended 0K Cancel | Apply |

Double-click the OPC group which you have created. The "OPC-Navigator"
opens. You will now see your protocols in the OPC-Navigator. Double-click
on "FDL". The connection name you configured in NetPro appears.
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Figure 7-2 OPC-Navigator

Nodes Leaves | Item Nam.. | Basi
=-{_] Connections
[+ gl DX
=& \DP2Z:
@& \DF:
= WFDL:
=@ ICP 561
+ @& FOL Connectionl
- WFMS:
[+ gl \WPNID:
g V5T
@& SNMP:
#& \SF:

[\FDL: is selected

Double-click the FDL connection to define new items and add existing
items respectively for the communication.

In the OPC-Navigator select "send". In the middle section appears an item.
Move this "send" item to the right section with the button "->".

Double-click the ,send“item in the right section.
Figure 7-3 adding the ,send‘item

F
| Nodes Leaves Iterm Mam... | Basis I Oighame The listed Item{s] will be added to Group:
= &% Connections 2> gand FDL(FDL.. FDL:[FDL Conn.. FDL:[FDL Connectionljsend
- @@ DX
[ §4 \OP2:
= @& \DF:
- |
& @ 0P 5611 Enter an item with the following Syntasx:
(=14 FDL Connectionl . -3 |
i send [Devicename]ltemname
',:,' ﬁ :ica:::: IFDL:[FDL Connection] Jsend £ |
= @ FMS: l
= #@ \PNI: Modify [tem LCancel
+ g \ST:
= @ \SNMP: [Enter an ltem
=& \SA:
e |[ oKk | Canca
| sendis selected 11/26/2004 | B20AM

Change the name of the ,send“item (see Figure 7-4 changing the name of
,send” item) and click the button "Modify Item".
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Figure 7-4 changing the name of ,send" item

x
Enter an iterm with the following Syntax:
[Devicenamelitemname

|FDL.[FDL ConnectionJsend10,80,10

Modify [tem Cancel

[Enter an ltem

The item "... send 10, BO ..." means, that a send buffer of 10 Bytes is
reserved on the PC station. Starting at Byte 0 of this buffer, 10 Bytes
are sent to the S5 station.

In the OPC-Navigator select "receive”. Move the existing “receive” item
which appears the middle section to the list in the right section with the
button "->".

Click the button “OK”.

Figure 7-5 adding the ,receive” item

[} oPC-Navigator N, x

Ngs Leaves | itemNam.| Basis Dighlame fzg?t %Lﬂl[l;ngglngi::]e]addgd:uﬁm
= Connections 2 receive F . : nnection] Jreceive
[+ DX Vi AL, A e FOL:[FDL Connection]jzend10.80,10

[+ \DP2:
[+ \DF:
B4 \FDL:
& @ ICP 5611

[=1_{ FDL Connection?
@] send
S-- |

1 receive
= @ alisses
WFMS:

® WPHID:

13 \ST:

13 \SMMP:

\SR:

&

o

¥

t

c3

frer | ok | Concel

| [P RS TR fmenna Noat aa

The items are added in the OPC Scout. If the quality is good the connection
is established and it's possible to read and write the items respectively.
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Figure 7-6 OPC-Scout

[EJoPC scout - New Project1

— =10],
Fle View Server Group Item 7
= 8 &gl [E2[¥ el +-|
lServe(s and groups ltems incl. status information
= g Serverls) Item N [ Value | Format Type | Access | Quality | Time Stamp (UTC)
&) Local Serverfs) 1 FDL[FDL ConnectionT Jsend10,B0,10 | {DIIDIDIOIOIOIC Driginal wint] ] AW good 01/26/2004 16:18:26.795
=) 4 Dpcﬂnat'u:n[] 2 |FDLIFDL C ionl receive {DIDIOIOIDIDION Drignal uint@[ ] R good 01/26/2004 16:18:26.795
FDL 3

3 [Mew group)
2 OFC SimaticNET DP
& OPC SimaticNET.PD
E ProfiDiive. ProfilServer
-8y Remote Serverls)
Sy, Add Remote Servers(s)

Double-click the column value of the "send" item to write values to the send
buffer.

Figure 7-7 writing values

Write ¥alue{s) to the Item(s) x|

Yalue
{10 In2nzn4nsnen Fnen S

— Formatcorwersion———

% Sunc wite
f+' Onginal ™ Async write
" Hes
£ Binary
OK Lancel Apply

The default structure of the value input {0]0} must not be modified. Only the
values themselves may be modifying {1|1}.

Even if only one byte has changed, all bytes of an array (as used here) will
always write in a write job.

Figure 7-8 successful write job

Item Names | Value Jrite Resu/ Error

1 FDLJFDL - Verhindung-1 ieceve 1001111203 3(1-
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With the services send and receive successful writing of data must be
checked in the columns ,Write Result“and ,Error“. The columns ,Write
Result“and ,Error‘can be made visible in the ,View - Options“menu.
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8 Basic configuration instruction
8.1 Interface number (SSNR)
e The interface number of the CP is assigned in the configuration tool of

the CP 5431 "SINEC NCM COM 5431" in the (Edit = CP Init) dialog.

e The SSNR must be specified as a parameter in all communication
blocks of the PLC (FB120, FB121, FB125, FB126 and FB127).

e The interface number must be divisible by 4 (0, 4, 8, 16...).

8.2 SEND (FB120) and RECEIVE (FB121), SEND_A (FB126) and
RECV_A (FB127), SYNCHRON (FB125)

o The values specified for QLAE and ZLAE are word values (QLAE =0,
10 - send 10 words; ZLAE =0, 10 - receive 10 words).

e The PAFE and ANZW parameters are output parameters. These are
used for diagnostics and job monitoring. For more detailed information,
refer to the manuals on the CPs.

e The job number (A-NR) specifies the connection configured on the CP
(see Figure 6-2 FB120 ,SEND" call and Figure 6-3 FB121 ,RECEIVE”
call).

e The blocks must be called using unconditional calls (for example JU
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